
Векторска графика 

Векторска графика је начин приказивања слике помоћу линија и облика. Увећавањем не губи 

на квалитету. 

До сада смо се бавили креирањем растерске графике, у седмом разреду ћемо се упознати са 

основним техникама за креирање и обраду векторске графике. Постоји велики број програма 

за креирање и обраду вексторске графике, и неки од њих су Inkscape, Corel Draw и Adobe 

Illustrator. 

У овом разреду, бавићемо се основним техникама за креирање и обраду дигиталних слика у 

програму Inkscape. 

Програм можемо да преузмемо са интернет странице https://inkscape.org/en/download. 

Када покренемо програм Inkscape отвара се нови документ који је у формату SVG (Scalable 

Vector Graphics). 

Радно окружење програма Inkscape приказано је на доњој слици: 

 

https://inkscape.org/en/download
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У радном окружење централно место чини бела површина, страница или платно за цртање чија 

је димензија 210mm x 297mm. То је простор на коме се постављају различити објекти, основни 

елементи тачке, линије, криве, кругове, многоуглове… који се користе за грађење дигиталне 

слике. Ти градивно елементи једним именом се називају објекти. Објекти могу да буду 

отворени и затворени, испуњени и неиспуњени, један испред другог, могу да се преклапају… 

формирајући слику. 

Да бисмо подесили величину или оријентацију платна за цртање потребно је да кликнемо на 

мени File (1) и одабиром опције Document Properties (2). Отвара се прозор са више картица. 

 

У оквиру картице Page можемо да променимо: 
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У оквиру картице Guides могуће је активирати приказ помоћних линија (вођица) на страници. 

Ове линије користе се за прецизно постављање објеката на страницу. 

 

Помоћне линије постављамо тако што кликнемо на лењир (хоризонтални или вертикални) и, 

држећи притиснут леви тастер миша, повлачимо линију под жељеним углом. 

Двоструким кликом на линију отвара се помоћни мени Guideline у оквиру кога подешавамо 

назив маргине (Label), боју, позицију или угао линије. 

Ако је за прецизно постављање потребно више помоћних линија можемо да учинимо 

видљивом мрежу помоћних линија. 
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У оквиру картице Grid можемо да одаберемо да ли да мрежа помоћних линија да буде 

правоугаона (Rectangular) или аксонометријска (Axonometric). 

 

У истој картици дефинишемо јединицу мере (Grid units), постављамо почетну координату 

(Origin X, Origin Y), као и размак између линија (Spacing X, Spacing Y). 

Цртање правоугаоних и овалних облика 

Програм Inkscape омогућава креирање основних геометријских облика избором одговарајуће 

алатке из Toolbox. 

Да бисмо исцртали правоугаоник или квадрат користимо Create rectangles and squares . 

Правоугаоник исцртавамо тако што кликнемо на платно за цртање и развучемо га држећи 

притиснут леви тастер миша, док квадрат исцртавамо на исти начин држањем притиснутог 

тастера Ctrl. 

Исцртавање елипсе или круга вршимо коришћењем алатке Create circles, ellipses and arcs . 

Елипсу исцртавамо тако што кликнемо на страницу и развучемо га држећи притиснут леви 

тастер миша, док круг исцртавамо на исти начин држањем притиснутог тастера Ctrl. 

Од исцртаног круга могуће је креирати кружне исечке и лукове коришћењем алатке Tool 

Controls Bar , у оквиру које је могуће да креирамо кружни исечак или лук или 

вратимо објекат у почетно стање. 
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Програм Inkscape омогућава креирање основних геометријских облика избором одговарајуће 

алатке из Toolbox. 

Да бисмо исцртали правилни многоугао користимо опцију Create stars and polygons , а 

затим у Tool Controls Bar одаберемо алатку  и унесемо број углова . Када смо подесили 

број углова, држимо притиснут леви тастер миша и развлачимо многоугао. 

На сличан начин исцртавамо звезду оодабиром алатке алатке . 

Да бисмо исцртали спирале користимо алатку Create spirals  и држимо притиснут леви 

тастер миша, развучемо спиралу. 

Цртање линија 

За цртање правих и неправилних линија користимо алатку Draw freehand lines . 

Да бисмо нацртали праву линију, потребно је да кликнемо левим тастером миша на страницу, а 

затим да преместимо курсор миша на место где желимо да буде крај дужи и поново кликнемо 

на страницу. 

За исцртавање неправилних линија потребно је да кликнемо левим тастером миша на страницу 

и држимо га притиснутог док цртамо линију жељеног облика. Када отпустимо тастер миша, 

завршавамо исцртавање линије. 

За цртање изломљених линија користимо алатку Bezier . 

Да бисмо исцртали изломљене линије, потребно је да кликнемо левим тастером миша на 

страницу, затим да преместимо курсор миша на место где желимо да изломимо линију, 

поново кликнемо и преместимо курсор миша, па понављамо ове радње све до крајње тачке 

изломљене линије, коју означавамо двокликом на страницу. 

 

Уметност лепог писања 

У програму Inkscape могуће је креирати објекте налик лепом писању - калиграфије. То 

остварујемо коришћењем алатке Calligraphy . 

Одабиром ове алатке добијамо могућност да цртамо посебне врсте линија - дебље или тање, 

под одређеним углом и правцем. 

Креирање текста 

Такође, у програму Inkscape је могуће креирати комплексне текстове, наслове, банере, логое 

или натписе. 
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За креирање текста потребно је да изаберемо алатку , кликнемо на страницу и унесемо 

текст. 

За форматирање текста потребно је да га селектујемо и из менија Text одаберемо опцију 

Convert to Text. 

На тексту можемо вршити измене: 

 фонта и његове величине; 

 хоризонталног и вертикалног растојања између речи или слова; 

 ротирања слова. 

Да бисмо направили те измене, потребно је да кликнемо између карактера и изаберемо 

одговарајуће подешавање у Tool Controls 

Bar . 

а предходна два часа смо креирали, тачније исцртавали различите геометријске облике 

(правоугаоник, квадрат, елипсу, праву линију, изломљену линију, спиралу,…). Сви ти објекти на 

страници не морају да буду постављени у истој равни, можемо да их стављамо један преко 

другог. Поређани су по нивоима, тако да се сваки нови објекат налази се на нивоу изнад 

претходног. 

У програму Inkscape могуће је променити редослед означених објеката коришћењем опција из 

менија Object: 

 Raise  да се објекат подигне; 

 Lower  да се објекат спусти; 

 Raise to Top (Подигни на врх)  да се објекат подигне на врх; 

 Lower to Bottom  да се објекат подигне на дно; 

 

Операције над објектима 

Да бисмо могли да вршимо манипулацију над објектима (померање, промена величине, 

ротација…) можемо да користимо алатку Selector . 

Када кликнемо на објекат користећи алатку за означавање (селекцију), око њега се формира 

оквир са 8 двостраних стрелица. Овакав објекат је спреман за све врсте манипулација, од 

померања, мењања величине, ротирања… 
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Померање објеката 

Објекат можемо да померамо само када је селектован и то превлачењем мишем или 

употребом стрелица на тастатури. Притиском стрелица на тастатури објекат се помера у 

жељеном смеру за 2 пиксела. Уколико држимо пристиснут тастер Shift и стрелице на тастатури, 

померање је 10 пута веће (20 пиксела). 

Опис поступка за померање објекта у програму Inkscape можете погледати на доњем видеу: 

 

Промена величине објеката 

Величину објекта мењамо кликом и повлачењем на одговарајуће двостране стрелице. Ширину 

или висину селектованог објекта мењамо кликом на двостране стрелице које су на средини 

страница оквира селектованог објекта и њиховим повлачењем. Ако кликнемо на двостране 

стрелице у угловима селектованог објекта истовремено мењамо и ширину и висину објекта. 

Пропорцију објекта, односно исти однос ширине и висине можемо да задржимо тако што 

током промене величине објекта држимо притиснут тастер Ctrl. 

Ротирање и нагињање објеката 

Да бисмо могли да ротирамо или нагињемо објекат, морамо да кликнемо на селектовани 

објекат чиме двостране стрелице мењају облик. 

Објекат ротирамо повлачењем одговарајуће двостране стрелице којa се налази на углу 

селектованог објекта. 

Објекат вертикално нагињемо повлачењем двостране стрелице која се налази на средини 

странице оквира селектованог објекта (са леве и десне стране). 

Објекат хоризонтално нагињемо повлачењем двостране стрелице која се налази на средини 

странице оквира селектованог објекта (горе и доле). 

 

Вишеструка селекција 

У програму Inscape могуће је више објеката селектовати како бисмо на њима извршили исте 

операције. Да бисмо селектовали више објеката потребно је да држимо притиснут тастер Shift 

и кликнемо на сваки од објеката. Број објеката које можемо да селектујемо на овај начин није 

ограничен. Ако желимо да селектујемо све објекте на страници, то радимо комбинацијом 

тастера Ctrl+A. 

Линију за контролу 

алатки 

 или помоћни мени Transform, који активирамо из менија Object (Object → Transform), 

користимо за прецизнију манипулацију над селектованим објектима. 
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Уређивање објеката 

Када поставимо објекат на страницу можемо да модификујемо, тачније, да мењамо његов 

облик. 

То радимо тако што из Toolbox одабиремо алатку Edit paths by nodes  и кликнемо на 

објекат који модификујемо. Приказаће нам се чворови беле боје. Њиховим повлачењем 

мењамо изглед делова објекта. 

Да бисмо мењали број углова и додавали нове чворове на објекту неопходно је да објекте 

претворимо у путање (Path). То чинимо тако што селектујемо објекат и из менија Path бирамо 

опцију Object to Path. 

Када је објекат претворен у путању на располагању су нам 4 различите врсте чворова: 

 cusp - угаони чворови који су намењени за креирање оштрих углова; 

 smooth - намењен за креирање глатких кривих; 

 symmetric - намењен за креирање кривих; 

 auto-smooth - за креирање идеално глатких кривих. 

За подешавање одговарајуће врсте чвора потребно је да кликнимо на постојећи чвор, а затим 

да одаберемо једну од опција:  које се налазе у Линији за контролу алатки. 

Објекат мењамо тако што повлачимо бели круг одговарајућег чвора. 

За додавање новог чвора довољно је да два пута кликнемо (двоклик) на жељено место на 

објекту. Да бисмо обрисали чвор, потребно је да га означимо, а затим притиснемо тастер 

Delete. За додавање и брисање чворова можемо да користимо и опцију  са Линије 

за контролу алатки. 

Комбиновање објеката 

У програму Inkscape могуће је креирати објекат уклањањем једног или више постојећих 

објеката, тачније могуће је извршити комбиновање више објеката креирајући потпуно нов 

објекат. 

Објекте комбинујемо тако што превучемо један објекат преко другог, селектујемо оба и 

изаберемо начин комбиновања (Union, Difference, Intersection, Exclusion, Divison, Cut Path) из 

менија Path. 
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Копирање и брисање објекта 

У програму Inkscape селектовани објекат можемо да корирамо на више начина: 

 коришћењем стандардних пречица са тастатуре (Ctrl+C, Ctrl+V); 

 десним кликом миша на објекат и одабиром из падајућег менија наредбе Copy и Paste; 

 избором пречица (Copy , Paste ) из Командне линије. 

Поред горе описаног начина копирања објеката у програму Inkscape могуће је извршити 

копирање и помоћу наредби Duplicate  и Clone  из Командне линије. Применом ових 

опција копирани објекти се појављују преко постојећих објеката па их је потребно померити на 

жељену позицију. 

Када селектујемо објекат и притиснемо тастер Delete бришемо објекат са радне површине. 

 

Поравнање објеката 

Да бисмо прецизно поравнали објекте можемо то урадити на два начина: 

https://petljamediastorage.blob.core.windows.net/root/Media/Default/Kursevi/OnlineNastava/7_razred_IKT_DigitalnaPismenost/L78S11.png
https://petljamediastorage.blob.core.windows.net/root/Media/Default/Kursevi/OnlineNastava/7_razred_IKT_DigitalnaPismenost/L78S12.png
https://petljamediastorage.blob.core.windows.net/root/Media/Default/Kursevi/OnlineNastava/7_razred_IKT_DigitalnaPismenost/L78S13.png
https://petljamediastorage.blob.core.windows.net/root/Media/Default/Kursevi/OnlineNastava/7_razred_IKT_DigitalnaPismenost/L78S14.png
https://petljamediastorage.blob.core.windows.net/root/Media/Default/Kursevi/OnlineNastava/7_razred_IKT_DigitalnaPismenost/L78S15.png


 да користимо помоћне линије, мрежу или 

 опције из помоћног менија Align and distribute objects  из Командне линије. 

У помоћном менију се налазе опције за поравнање објеката (Align) и усклађивање размака 

(Distribute) измећу објеката. 

 

 

Симетрично пресликавање 

Да бисмо симетрично пресликавање објеката користимо помоћни мени Path Effects из менија 

Path. Објекат мора да буде селектован да бисмо објекат симетрично пресликали. У помоћном 

менију Path Effects одаберемо опцију . Отвара се додатни мени у којем бирамо опцију 

Mirror symmetry. 

У оквиру менија Path Effects налазе се опције којима се подешава: 

 Mode - начин пресликавања; 

 Start mirror line - почетне координате осе симетрије у односу на које се врши 

пресликавање; 

 End mirror line - крајње координате осе симетрије у односу на које се врши 

пресликавање; 

 Mirror symmetry - избор ефекта. 

Груписање и разлагање објеката 

На страници више објеката може да формира једну групу тако да се са њима може 

истовремено манипулисати. Таква група делује као један објекат. Групу формирамо од 
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селектованих објеката кликом на опцију Group selected objects  из Командне линије. 

Разлажемо групу на појединачне објекте кликом на опцију Ungroup selected groups . 

 

Промена боје објекта 

Сваки објекат у програму Inkscape је дефинисан унутрашњом облашћу (Fill) и ивицом (Stroke). 

Унутрашњој области и ивицам можемо независно да мењамо боју. Промену боје унутрашње 

области или ивице селектованог објекта или групе вршимо избором жељене боје из палете 

боја. 

 

Кликом на боју поред назива Fill: и Stroke: отвара се помоћни мени Fill and Stroke у коме се 

врше детаљна подешавања изгледа унутрашње области и ивице објекта. 

 

Помоћни мени Fill and Stroke можемо да покренемо и из менија Object (Object → Fill and 

Stroke). 

Векторизација растерске слике 

Процес којим фотографију/слику претварамо у векторски цртеж, графички формат који не губи 

квалитет приликом увећавања називамо векторизација. 

У програму Inkscape могуће је претварање растерске слике у векторску коришћењем опције 

Trace Bitmap (Path → Trace Bitmap). Избором већег броја скенирања (Scans) и избором из листе 

више боја (Colors) добија се квалитетнија векторска слика. 
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